Banner Admin (INB) Navigation Training Guide

Course Overview

Lesson 1: Introduction to Banner Admin (INB)
Lesson 2: Logging On to Banner Admin (INB)
Lesson 3: Banner Admin Elements
Lesson 4: Banner Searching
Lesson 5: User Preferences
Lesson 6: Banner Help

Appendices
Online Course Assignments

Developed by the Enterprise Information Systems Team
College of William and Mary
1/11/2010
Welcome to Banner Admin (INB) Online Navigation Training!

This course is self-paced. You decide how fast you proceed through the course. There are six (6) lessons. Each has assignments and review questions to do.

You must complete all review questions and the Final Certification Test, with at least an 80% score. The Course Evaluation is optional, but your comments and suggestions are welcome and help us improve our training materials.

The course is hosted in Blackboard. Inside each lesson folder you'll find the video, assignments and review questions.

Need Help?

If you need assistance during the training, please contact Bonnie Fleming or Nancy Pavelich.
Watch Video

- Start the video by clicking the link. To stop the video before it has ended, right click your mouse and select "Play".
- To restart the video, right click and select "Play" again.
- To exit the video when it is finished, click your browser Back button and on the next screen click "OK" to proceed to Assignments.
- If the video does not play, refer to Appendix A.

Do Assignments

- Each assignment is a hands-on assignment.
  For some assignments you'll need to log into the Banner test environment.
- Each assignment is designed to reinforce the video discussion.

Review Questions

- After completing the assignments, you'll need to answer several review questions.
- You must score at least an 80% on the review questions to complete each lesson.
Lesson 1: Introduction to Banner Admin (INB)

Banner Functional Areas
Banner has five (5) functional areas:

- Student
- Financial Aid
- Finance
- Human Resources
- Fixed Assets

Integrated System
- All functional areas share one (1) common database.
- In an integrated system, only one record should be created for each individual or vendor.
- Each record in Banner has a unique identification number referred to as a PIDM (Personal Identification Master).
- Duplicate PIDMs cause major problems in Banner. We’ll cover proper Search Techniques used to avoid creating them.
Lesson 1: Introduction to Banner Admin (INB)

Banner Self Service
- Web-based, accessible through myWM.
- Access given to ALL students, faculty and staff.
- Used by students to register for classes, check grades, update addresses.
- Used by faculty and staff to enter timesheets, check budgets, etc.

Banner Admin (INB)
- Web-based, accessible through a browser, Internet Explorer is recommended.
- Access restricted to users who require it for their jobs.
- Both Banner Admin (INB) Navigation Training and functional training must be completed before access is granted.
Information Security Policies

- All data in Banner protected by Federal Privacy laws as well as College Security Policies
- Found on IT website under security: www.wm.edu/it
- Passwords are personal and private.
- Against W&M Information Security Policy to log in for a coworker, to show data to others or to download it for any use other than your work.

Family Education Rights & Privacy Act

- FERPA - federal law protecting the privacy of student education records.
- To view the complete text of FERPA:

Data Standards

- Specific guidelines for the integrity and accuracy of data entered into Banner.
- Found at www.wm.edu/it under Services - Banner under Training.

Failure to follow these policies and safeguard confidential information may result in disciplinary action, up to and including dismissal.
System Requirements

- Banner Admin runs in an internet environment. Internet Explorer (I.E.) is the preferred browser.
- Make sure that you have the most recent version of I.E.
- In order to function properly, Banner Admin needs the latest version of the Java plugin.
- Configure I.E. to block pop-ups but allow pop-ups from *.wm.edu and *.microsoft.com:
  1. Click on Tools on the I.E. menu.
  2. Select Pop-up Blocker, then Pop-up Blocker Settings.
  3. Add *.wm.edu and *.microsoft.com if they are not already there.

- Ensure your computer is configured with trusted sites: *.wm.edu and *.microsoft.com.
  1. Click on Tools on the I.E. menu.
  2. Select Internet Options, then select the Security tab.
  3. Select Trusted Sites, then click on Sites: *.wm.edu and *.microsoft.com should already be there.
  4. Screen resolution must be set to 1024 x 768 in XP. (See appendix B.)
Lesson 2: Logging on to Banner Admin (INB)

Banner Links

- Access Banner links from www.wm.edu/it, Services-Banner
- Click on Banner Admin (INB).
- Scroll down on the page for links to Banner instances.

Requirements for Access
1. Complete and submit Request for Access to Banner and Banner Confidentiality Agreement. Follow instructions for submission.
2. Complete the Banner Admin Navigation Training. Course must be passed before access is given.
3. Functional training is usually required.

Links to Banner Admin Databases
Banner users will primarily use the PROD database of Banner Admin. So what does PROD mean anyway? PROD stands for production - as in the production of live data. The other Banner databases are primarily used for testing and training.

- PROD - Production area
During training, you will use the TEST database.
- TEST - For training purposes as well as a long-term testing area
Only a handful of Banner users will use the following Banner databases (and you know who you are.) These databases are refreshed weekly on Sunday nights.
- USER - Administrative testing and troubleshooting
- PPRD - Final testing area for the development of new programs
- DEVI - Development of new programs. (Designated for IT development)
- UPGR - Upgrade Testing
Use Discover to run reports from Banner.
Lesson 2: Logging on to Banner Admin (INB)

Logging On

- Go to the Banner Admin page and click on PROD.
- Review the FERPA warning and click Accept. (If you click Decline, Banner Admin will close.) (1)
- Type in your login information:
  1. Enter WMuserID in the Username field.
  2. Enter Banner password. (Remember, your Banner password is different than your email password.)
  3. Database auto-populates based on the Banner database link you clicked.
  4. Click Connect.

- NOTE: Two windows open. Both windows must remain open or Banner will close.
  - Main Menu
  - To exit Banner, click the black X.
Lesson 3: Banner Admin Elements – Main Menu

Main Menu Page

- Menu Bar - contains pull-down menus of functions and commands. If the menu item is gray, the item is disabled for that form. (1)
- Title Bar - shows the form name, 7-character abbreviation, version number and database name. (2)
- Go To box - type in the 7-character form name and press enter. (3)
- Double click folders to display content. (4)
- Help Center. (5)
- My Links. (6)
- The W&M logo has been added to My Institution (lower right). Click the My Institution link to go to the myWM page. (7)
- Auto Hint Line - displays a variety of information. (8)
Lesson 3: Banner Admin Elements – Opening

Opening Forms

Three ways to open forms

- Go to Box (1) Enter the name of the object (form, menu, job or Quickflow) in the Go To box.
- Banner Menu (2) Double click on the form name within the menu.
- Direct Access (3) Select File>Direct Access or click F5 to open a Go To menu while in a form.

Shortcuts

In the Go To field use the up and down arrow keys to scroll through the last ten forms opened.
Lesson 3: Banner Admin Elements – Forms

Form Elements

- **Key Block** – (1) determines what is entered or displayed in a form. Must use **Next Block** to move to the Information Block. Likewise, to return to the Key Block must use **Rollback** function.

- **Information Block** - (2) different sections of a form containing information about a person. Use the **Next Block** function, **Options** menu, or click on the tabs to navigate through blocks.

- **Field** - (3) area where you can enter, query, change and display specific information. Quickest way to navigate through fields is the TAB key.

- **Search Icon** - (4) Clicking this icon may open a query related form or a list of valid values.

- **Calendar Icon** - (5) Click the icon to display a calendar. Defaults to current day. Enter the current date in a date field by typing any character. Or just enter the day and the current month and year will default.
Many forms are now “tabbed”. Tabs contain the blocks of information opened by clicking “Next Block”. The main tab is always the first block. Blocks can be navigated by clicking the Next Block/Previous Block icons.

To navigate with tabs:

- Click the tab.
- Use F2 to open a tab menu - use up and down arrows to make selection.
- Use Ctrl + Tab to navigate forward through the tabs or Ctrl + Shift + Tab to navigate backward.
- Click the Block icons on the toolbar.
Shortcuts for Navigating Tabs

- Right click anywhere on the background of an open form (not available on the Main Menu) to open an Options menu. Options include: Save, Exit, Rollback, Print, Add to Personal Menu, form specific options and other related forms.

- Use **Add to Personal Menu** in the Options Menu to add form names to My Banner without opening the Preferences Form.

- Use **F5** to open the Go To box at the top of the form.

- Use the up and down arrows to access any of the last ten forms used, or go to the File drop down menu.
Navigation icons are at the top of each form. As with most programs, there are several means of navigation. For a list of keyboard shortcuts, refer to Appendix D.

- **Save** - Saves all changes made. Banner also refers to save as Commit in some messages.
- **Rollback** - Clears all information and return you to the Key Block of a form.
- **Insert Record/Remove Record** - enter or remove records.
- **Previous Record/Next Record** - scroll through record information. Can also use the scroll bar.
- **Previous Block/Next Block** - navigate through blocks of information including those in a tabbed form.
- **Enter Query** - enter a new search.
- **Execute Query** - execute the search.
- **Cancel Query** - cancel the search.
- **Print** - Captures the active screen (only what you see) and prints it to your local printer.
- **Online Help** - open the SCT Help Center.
- **Exit** - use to exit forms and for exiting Banner.

Reminder:
use “X” to close screens – do not use “x” in the upper right of the browser screen.
Lesson 3: Banner Admin Elements – Form Types

You will use Banner forms to enter, update, and query information. The types of forms you use most are Menu, Application, Query, and Validation forms.

- **Menu Form** - (1) Lists of related forms, menus and QuickFlows.
- **Application Form** - (2) Used to enter, update, and view information. You can also search for information in these forms.
- **Query Form** - (3) Used to retrieve information and bring it back to an application form.
- **Validation Form** - (4) Used to define the values that can be entered into specific forms. Easily accessed though the Search icon.
Lesson 4: Banner Admin Searches

Most users will, at some point, perform a search or query within Banner. Searchable fields have a Search icon that looks like a drop down arrow next to them. When the icon is clicked, either a list menu or a search form opens.

- **Wildcards** - (1) Percentage (%) and Underscore (_) signs. Percentage sign (%) can be used at the beginning, middle, or end of a word and can represent any character or a set of characters. The Underscore sign (_) represents one character but can be used multiple times.

- **List Menu** - (2) Contains lists of values. Notice this list menu, like most of them, has a Find field at the top. Wildcards can be used in this field to quickly find an entry without scrolling through the table. Lists of Values are clearly defined and relatively easy to display. When a entry is found, simply double click and it will be automatically entered into the form field.

- **Search Form** - (3) Use to find information that may reside in many different tables.
Lesson 4: Banner Admin Person Search

Person Search
1. Enter ID (93 number) if known
   OR
1. Click the Search icon next to the ID field.
2. Select Person Search from the Options List.
3. Enter Last Name
4. Enter First Name
5. Click the **Execute Query** icon or **F8**.
6. NOTE: You can make the search case sensitive if you click the radio button.

Example:
- Enter flem% to find Fleming or Flemming
- Enter m%c%don% to find McDonald or Mac Donald
- Enter o%con% to find O’Connell or O Conell or Oconnell

You should always assume that the person/entity DOES exist in Banner and you must use an EXHAUSTIVE search process to find them.
Lesson 4: Banner Admin Searches - GUIALT

Non-Person Search

1. Enter ID (93 number) if known

OR

1. Click the Search icon next to the ID field.

2. Select Non-Person Search from the Options List.

3. Enter Name

4. Click the Execute Query icon or F8.

Example:

- Enter %colonial%office%equipment% to find any companies with these three words, in this order, in the name.
Lesson 4: Banner Admin Searches - GUIALT1

Alternate ID Search (GUIALT1)

1. Click the Search icon next to the ID field.
2. Select Alternate ID Search from the Options List.
3. Enter SSN/TIN number.
4. Click the Execute Query icon or F8.
5. NOTE: You must search using SSN/TIN if you have access to the information. If no matches are found, then you MUST search by Name.

You can only search on SSN/TIN if you have access. You will be able to open the form even if you don’t have access to SIN/TIN.
Lesson 4: Banner Admin Searches – ID & Name

ID and Name Extended Search

1. Enter name (including wildcards) directly into the Name field.
   - Must be in Last Name, First Name format.
2. Press the Enter key.
3. If only one match, ID number is populated.
   - If more than one match is found, the ID and Name Extended Search box displays.
4. Click drop down arrow to view results. Double click the name to return it to the Name field.
   - Number of matches found.
5. Narrow the search by entering additional criteria such as: City, State, Birth Date and Gender. Use the Reduce Search icon to rerun the search.
GUAUPRF is the User Preferences Form. File>Preferences also opens the form. You can now control some aspects of the appearance of Banner screens.

**Display Options Tab**

- **Display Options (1)** allows control over name display on the Title and Menu Bars.

- **User Interface Color Settings (2)** (right) control your Banner color scheme. Use the scroll bar to see all color control options.

- Arrows by the User Value fields open Color Selection windows. A preview pane simulates the chosen color.

- Reset (3) the default colors on the Color Selection Window by clicking Reset and OK. Use to select color for text to indicate LOV and Searchable fields.

- Use **Alert Options (4)** to turn alerts on and off. By default a prompt asks if you want to end your Banner session. This prompt can be turned off.

- Use **Data Extract (5)** to control whether a header row is downloaded with the data.
Lesson 5: User Preferences

Menu Settings Tab

1. Use to personalize your start up menu. (1)

1. Set “My Banner” to open at start up by clicking the arrow by User Default.
2. Select *PERSONAL from the list.
3. Click the Save icon.
4. Close GUAUPRF.

Adding Forms to My Banner

1. Open GUAPMNU.
2. For the Type, select Oracle Forms module. (2)
3. Double click a form name (text will turn blue) and then use the Insert arrow to push the form to the right hand column. (3)

   OR

Enter the 7 character form name in the Object column and press the Enter key. (4)
4. Remove forms by reversing the process.
5. Save the changes.

New forms won’t appear in your folder until you log out and log back into Banner
Changing Your Password in Banner Admin

Banner Admin passwords expire every 90 days. You will be prompted when it’s time to change your password.

You can change your password at any time by clicking the Change Banner Password on the main menu or by opening the GUAPSWD form. (1)

1. Enter your current Banner password in the Oracle Password field.
2. Leave the Database field blank.
3. Enter a new Banner password in the New Oracle Password field.
4. Enter the same password from Step 3 in the Verify Password field.
5. Click the Save icon. (2)

Password Rules

- Passwords must be between 6 and 15 characters and include at least 1 letter and 1 number.
- Special characters are not allowed, except the underscore. WMuser IDs and other simple words won’t be accepted.
- Passwords CANNOT be re-used before 10 changes.
- Make your Banner password different from your network/email password.
- Don’t write it down!
Resetting your Banner Admin password through Banner Self Service

You can reset your Banner Admin password through Banner Self Service.

1. Log into myWM.
2. Select Banner Self Service.
3. Select any menu item, i.e., Personal Information.
4. A Reset Banner Password tab displays.
5. Select Reset Banner Password menu item and follow the screen prompts to generate a temporary password.
The online Help Center is launched in a separate browser window without closing your Banner session.

Open the Help Center in three different ways:

- Help Menu on the menu bar. (1)
- Help icon on the toolbar. (2)
- Help Center link above the My Links section. (3)

For additional Help, contact the operational area as listed under Banner Support.
Help Menu

The Help drop down menu has several related help items. Dynamic Help and Help Item properties.

- Show Keys is a table Keyboard shortcuts. (1)

- List opens a form called GUIOBJ. Use it to find forms, jobs, and Quick Flows. This is the same search form that opens from the Go To field. (2)
The William & Mary Banner website can be opened from the Banner Admin Main Menu page or by going to www.wm.edu/it/banner.

- Link to Banner PROD. (1)

- Link to Training & Guides. (2)

- Links to all Banner instances and Discoverer. (3)

For additional Help, contact the Technology Support Center at 1-HELP (14357).
Appendix A: Adding a Trusted Site

For Internet Explorer:

1. Open Internet Explorer and select Tools>Internet Options.
2. Click on the Security tab.
3. Click on Trusted Sites and then click the Sites button.
4. In the Add this website to the zone box type in *.blackboard.wm.edu.
5. Click the Add button.
6. Click Close.
7. Click OK.
8. Reopen the Blackboard class and watch the video.
## Appendix B: Form Naming Conventions

**POSITION 1:** Identifies the primary system owning the form, report, job or table.

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Alumni/Development</td>
<td>K</td>
<td>Work Management</td>
</tr>
<tr>
<td>B</td>
<td>Property Tax</td>
<td>L</td>
<td>Occupational Tax/License</td>
</tr>
<tr>
<td>C</td>
<td>Courts</td>
<td>N</td>
<td>Position Control</td>
</tr>
<tr>
<td>D</td>
<td>Cash Drawer</td>
<td>O</td>
<td>Customer Contact</td>
</tr>
<tr>
<td>E</td>
<td>XtenderSolutions</td>
<td>P</td>
<td>HR/Payroll/Personnel</td>
</tr>
<tr>
<td>F</td>
<td>Finance</td>
<td>Q</td>
<td>Electronic Work Queue</td>
</tr>
<tr>
<td>G</td>
<td>General</td>
<td>R</td>
<td>Financial Aid</td>
</tr>
<tr>
<td>I</td>
<td>Information Access</td>
<td>S</td>
<td>Student</td>
</tr>
<tr>
<td>T</td>
<td>Accounts Receivable</td>
<td>U</td>
<td>Utilities</td>
</tr>
<tr>
<td>V</td>
<td>Voice Response</td>
<td>W</td>
<td>Reserved for client</td>
</tr>
<tr>
<td>X</td>
<td>Records Indexing</td>
<td>Y</td>
<td>applications that co-exist</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Z</td>
<td>with Banner</td>
</tr>
</tbody>
</table>
### Appendix B: Form Naming Conventions

**POSITION 2** – Identifies the module owning the form, report, job or table.

<table>
<thead>
<tr>
<th>Advancement (A)</th>
<th>Financial Aid (R)</th>
<th>HR/Payroll/Personnel (P)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A</strong> Membership</td>
<td><strong>B</strong> Budgeting</td>
<td><strong>A</strong> Application</td>
</tr>
<tr>
<td><strong>D</strong> Designation</td>
<td><strong>C</strong> Record Creation</td>
<td><strong>B</strong> Budget</td>
</tr>
<tr>
<td><strong>E</strong> Event Management</td>
<td><strong>E</strong> Electronic Data Exchange</td>
<td><strong>C</strong> COBRA</td>
</tr>
<tr>
<td><strong>F</strong> Campaign</td>
<td><strong>F</strong> Funds Management</td>
<td><strong>D</strong> Benefit/Deduction</td>
</tr>
<tr>
<td><strong>G</strong> Pledge and Gift/Pledge Payment</td>
<td><strong>H</strong> History and Transcripts</td>
<td><strong>E</strong> Employee</td>
</tr>
<tr>
<td></td>
<td><strong>J</strong> Student Employment</td>
<td><strong>H</strong> Time Reporting/History</td>
</tr>
<tr>
<td><strong>L</strong> Label</td>
<td><strong>L</strong> Logging</td>
<td><strong>O</strong> Overall</td>
</tr>
<tr>
<td><strong>M</strong> Prospect Management</td>
<td><strong>N</strong> Need Analysis</td>
<td><strong>P</strong> General Person</td>
</tr>
<tr>
<td><strong>O</strong> Organization</td>
<td><strong>O</strong> Common Functions</td>
<td><strong>R</strong> Electronic Approvals</td>
</tr>
<tr>
<td><strong>P</strong> Constituent/Person</td>
<td><strong>P</strong> Packaging &amp; Disbursements</td>
<td><strong>S</strong> Security</td>
</tr>
<tr>
<td><strong>S</strong> Solicitor Organization</td>
<td><strong>R</strong> Requirements Tracking</td>
<td><strong>T</strong> Validation/Rule Table</td>
</tr>
<tr>
<td><strong>T</strong> Validation/Form Table</td>
<td><strong>S</strong> Student System Shared Data</td>
<td><strong>U</strong> Utility</td>
</tr>
<tr>
<td><strong>U</strong> Utility</td>
<td><strong>T</strong> Validation Form/Table</td>
<td><strong>V</strong> Reserved-Can. Solution Ctr.</td>
</tr>
<tr>
<td><strong>V</strong> Reserved-Can. Solution Ctr.</td>
<td><strong>U</strong> Utility</td>
<td><strong>X</strong> Tax Administration</td>
</tr>
<tr>
<td><strong>X</strong> Expected Matching Gift</td>
<td><strong>V</strong> Reserved-Can. Solution Ctr.</td>
<td></td>
</tr>
</tbody>
</table>
### Appendix B: Form Naming Conventions

**POSITION 2 (cont.)** – Identifies the module owning the form, report, job or table.

<table>
<thead>
<tr>
<th>Finance (F)</th>
<th>General (G)</th>
<th>Student (S)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Accounts Payable</td>
<td>E Event Management</td>
<td>A Admissions</td>
</tr>
<tr>
<td>B Budget Development</td>
<td>J Job Submission</td>
<td>C Catalog</td>
</tr>
<tr>
<td>C Cost Accounting</td>
<td>L Letter Certification</td>
<td>E Support Services</td>
</tr>
<tr>
<td>E Electronic Data Interchange</td>
<td>O Overall</td>
<td>F Registration/Fee Assessment</td>
</tr>
<tr>
<td>F Fixed Assets</td>
<td>P Purge</td>
<td>G General Student</td>
</tr>
<tr>
<td>G General Ledger</td>
<td>S Security</td>
<td>H Grades/Academic History</td>
</tr>
<tr>
<td>I Investment Management</td>
<td>T Validation/Form Table</td>
<td>I Faculty Load</td>
</tr>
<tr>
<td>N Endowment Management</td>
<td>U Utility</td>
<td>K Reserved-SCT Intl. UK</td>
</tr>
<tr>
<td>O Operations</td>
<td>V Reserved-Can. Solution Ctr.</td>
<td>L Location Management</td>
</tr>
<tr>
<td>P Purchasing/Procurement</td>
<td>X Cross Product</td>
<td>M CAPP</td>
</tr>
<tr>
<td>R Research Accounting</td>
<td>A Accounts Receivable (R)</td>
<td>O Overall</td>
</tr>
<tr>
<td>S Stores Inventory</td>
<td>F Finance Accounts Receivable</td>
<td>P Person</td>
</tr>
<tr>
<td>T Validation/Form Table</td>
<td>G General Accounts Receivable</td>
<td>R Recruiting</td>
</tr>
<tr>
<td>U Utility</td>
<td>O Overall</td>
<td>S Schedule</td>
</tr>
<tr>
<td>V Reserved-Can. Solution Ctr</td>
<td>R Research Accounting</td>
<td>T Validation/Form Table</td>
</tr>
<tr>
<td>X Archive/Purge</td>
<td>S Student Accounts Receivable</td>
<td>U Utility</td>
</tr>
<tr>
<td>Information Access/Kiosk (I)</td>
<td>T Validation Form/Table</td>
<td>V Reserved-Can. Solution Ctr</td>
</tr>
<tr>
<td>R Financial Aid</td>
<td>U Utility</td>
<td></td>
</tr>
<tr>
<td>S Student</td>
<td>V Reserved-Can. Solution Ctr</td>
<td>T Validation/Form Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X XtenderSolutions</td>
</tr>
<tr>
<td><strong>All Products</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>W Reserved for client forms or modules used within a Banner application</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y (Character in position 1 does not equal W, Y or Z)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Z</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Banner Admin (INB) Navigation Training Guide – V 8.2
## Appendix C: Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Function</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Form</strong></td>
<td></td>
</tr>
<tr>
<td>Rollback</td>
<td>Shift+F7</td>
</tr>
<tr>
<td><strong>Block</strong></td>
<td></td>
</tr>
<tr>
<td>Next Block</td>
<td>Ctrl + PgDn</td>
</tr>
<tr>
<td>Previous Block</td>
<td>Ctrl + PgUp</td>
</tr>
<tr>
<td><strong>Record</strong></td>
<td></td>
</tr>
<tr>
<td>Insert Record</td>
<td>F6</td>
</tr>
<tr>
<td>Remove Record</td>
<td>Shift + F6</td>
</tr>
<tr>
<td>Duplicate Record</td>
<td>F4</td>
</tr>
<tr>
<td>Next Record</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Previous Record</td>
<td>Up Arrow</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td></td>
</tr>
<tr>
<td>Next Field</td>
<td>Tab</td>
</tr>
<tr>
<td>Previous Field</td>
<td>Shift + Tab</td>
</tr>
<tr>
<td><strong>Query</strong></td>
<td></td>
</tr>
<tr>
<td>Enter Query</td>
<td>F7</td>
</tr>
<tr>
<td>Execute Query</td>
<td>F8</td>
</tr>
<tr>
<td>Cancel Query</td>
<td>Ctrl+Q</td>
</tr>
<tr>
<td><strong>Other</strong></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>F10</td>
</tr>
<tr>
<td>List of Values</td>
<td>F9</td>
</tr>
<tr>
<td>Direct Access</td>
<td>F5</td>
</tr>
<tr>
<td>Options List</td>
<td>F2</td>
</tr>
<tr>
<td>Print</td>
<td>Shift + F8</td>
</tr>
<tr>
<td>Exit</td>
<td>Ctrl + Q</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
</tbody>
</table>

Use the Help menu and select Show Keys for shortcuts.
Lesson 1 Assignments

2. Navigate to www.wm.edu/registrar/ferpa.php and review the FERPA policy for general content. Review what is considered Directory Information. Click the link to view the policy; use your Back button to return to the lesson.
3. Review the Acceptable Use Policy for Faculty and Staff. Click the link to view the policy; use your Back button to return to the lesson.

Lesson 2 Assignments

1. Change your screen resolution to 1024 x 768. Refer to Appendix A in the Banner Admin (INB) Navigation Training Guide.
2. Go to the Banner website – Banner Admin. Log in to Banner Admin (TEST) using your W&M ID and the password given to you in your Training email.

Lesson 3 Assignments

1. Open Banner Admin. (Open the TEST instance of Banner)
2. Enter SPAIDEN in the Go To box.
3. Tab to the name field.
4. Enter Aery, Margaret.
5. Press the Enter key. The Key Block is now populated with the 93 number and the full name.
6. Click the Next Block icon. The Current Identification tab is populated.
7. Click the Next Block icon. The Alternate Identification tab opens.
8. Click the Address tab to view the address.
9. Click the Rollback icon to return to the key block.
10. Select Block from the menu bar and Clear to clear the Key Block.
11. Enter 930260731 in the ID field.
12. Click Next Block.
13. Right click on the canvas to open the Options menu.
14. Select Addresses. The Address tab is opened.
15. Click the Exit icon to close the form.
Lesson 4 – Assignment 1

Find a person named Bob Ackerman. His address is 40 Aaron Ln, Indiana, PA 15701.

1. Open Banner Admin (Use the TEST instance).
2. Type SPAIDEN in the Go box. Press Enter and the SPAIDEN form displays.
3. Click the Search icon in the Key Block next to the Name field.
4. Select Person Search from the Options List and the SOAIDEN form displays.
5. Enter Ackerman in the Last Name field, Bob in the First Name field.
6. Perform an Execute Query.
7. The screen appears unchanged; however, if you view the Auto Hint line is says “Query caused no records to be retrieved. Re-enter.”
8. Click the Cancel Query icon.
9. Click the Enter Query icon.
10. Tab to the Last Name field and enter Ackerman.
11. Perform an Execute Query. The results display beginning with Ackerman, Aaron and ending with Ackerman, William. There is no Bob Ackerman.
12. Double-click on the row for Robert K. Ackerman to return it to the SPAIDEN form.
13. Perform a Next Block. NOTE: The preferred first name is Bob.
14. Select the address tab. Verify the address.
15. In this example the Bob is a typical nickname for Robert. The address record matches the address given. You can assume this is the correct individual.
Lesson 4 – Assignment 2

Find a person named Amanda O’Connell. Her address is 30903 Avenida Del Reposo, Temecula, CA 92591.

1. Open Banner Admin, TEST.
2. Type SPAIDEN in the Go box. Press Enter and the SPAIDEN form displays.
3. Click the Search icon located in the Key Block next to the Name field.
4. Select Person Search from the Options List and the SOAIDEN form displays.
5. Enter o%con% in the Last Name field and A% in the First Name field.
6. Perform an Execute Query. The results display.
7. Locate the two Amanda O’Connells. You will need to view both records to determine if either one is a match. Double-click on the row for Amanda Kay O’Connell to return it to the SPAIDEN form.
8. Perform a Next Block. Select the Address tab. The address does not match.
10. Enter o%con% in the Last Name field and Amanda in the First Name field.
11. Perform an Execute Query and the results display.
12. Double-click on the row for Amanda Susan O’Connell to return it to the SPAIDEN form.
13. Perform a Next Block.
14. Select the Address tab. The address matches.
Lesson 4 - Assignment 3

Find the vendor Colonial Capital Bed & Breakfast.

1. Open Banner Admin (TEST). Type FAIVNDH in the Go box.
2. Press the Enter key and the FAIVNDH form displays.
3. Tab to the Name field.
4. Enter Colonial Capital Bed & Breakfast in the Name field. (Remember, this field is case sensitive.)
5. Press Enter.
6. No results are displayed – the auto hint line reads "ERROR* Name is invalid."
7. Click the Search icon located in the Key Block next to the Vendor field.
8. Select Entity Name/ID Search (similar to a Non-Person Search) and the FTIIDEN form displays.
9. Enter %Colonial%Bed% in the Last Name field. (NOTE: Last Name field is case sensitive.)
10. Perform an Execute Query. The results display.
11. Double-click on the row for Craig P W DBA Colonial Bed & Breakfast to return it to the FAIVNDH form. (NOTE: in this example the vendor name is Craig P W Doing Business As Colonial Bed & Breakfast.)
12. Perform a Next Block to view the vendor history (which is blank).

Lesson 4 - Assignment 4

Find Lauren Appleton-Webster by entering the name with wildcards in the Name field. Her address is Fairfield, CT.

1. Open Banner Admin (TEST). Type SPAIDEN in the Go box.
2. Press the Enter key and the SPAIDEN form displays.
3. Tab to the Name field.
4. Enter %Webster,Lauren or Appleton%,Lauren. (Remember, it's case sensitive.)
5. Press the Enter key. The name field displays Lauren Appleton-Webster.
6. Perform a Next Block.
7. Select Options.
8. Select Addresses. The address matches.
Lesson 5 - Assignment 1
1. Open Banner Admin (TEST).
2. Open SPAIDEN. Note the information in the top left of the form (General Person Identification SPAIDEN 7.3 (TEST).
3. Open GUAUPRF and deselect all four Display Options.
4. Close GUAUPRF, click “yes” to save changes.
5. Open SPAIDEN again. Note: display information is missing.
6. Go back to GUAUPRF and turn on all Display Options.

Lesson 5 - Assignment 2
1. Open Banner Admin (TEST).
2. Go to the Menu Settings tab on GUAUPRF.
3. Click the down arrow next to the User Default field to open the list of menus.
4. Find and add the “PERSONAL” menu to your Main Menu to set your “My Banner” folder to open on start up.
5. Remember, you are still in the Test instance of Banner. Changes made here won’t appear on your PROD account.

Lesson 5 - Assignment 3
Open Banner Admin (TEST). Add a personal link to your Main Menu.
(Hint: click on any undesignated personal link to open the form, go to the My Links tab).

Lesson 6 - Assignment 1
1. Open Banner Admin (TEST).
2. Open the Help Center from the drop down menu under Help in the toolbar.
3. The General folder should appear in the left navigation pane.
4. Find the GUAUPRF form.
5. Find the GUAPSWD form.
6. Time permitting, search for the topic of your choice.

Lesson 6 - Assignment 2
1. Open Banner Admin (TEST), open the Help Center from the link at the top of the right navigation pane, above My Links.
2. Find documentation for the Student SPAEMRG form.